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ABSTRACT 
 

This study examined the neuroprotective effects of ethanolic leaf extract from Causonis trifolia (L.) on Alzheimer's 

disease in Wistar rats produced by aluminum chloride (AlCl3). Bioactive substances like 9-octadecanoic acid were found by 

phytochemical and GC-MS studies, and molecular docking supported their interaction with important targets for 

Alzheimer's disease. In vivo tests revealed that, in comparison to untreated disease controls, treatment with the extract at 

doses of 150 and 300 mg/kg, along with donepezil, significantly increased locomotor activity, decreased anxiety, and 

improved memory retention in behavioral tests (IR Actimeter, Elevated Plus Maze, and Novel Object Recognition). 

Furthermore, the extract reduced neurodegenerative damage in striatal tissue and restored antioxidant enzyme activity 

(SOD and CAT). All things considered, the results show that Causonis trifolia has encouraging anti-Alzheimer's properties, 

most likely due to its antioxidant processes. 
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CHAPTER ONE 

INTRODUCTION 
 

 Introduction: 

The prevalence of age-related illnesses among the elderly has grown to be a significant worldwide health issue as the populace 

ages. Dementia results from the continuous and permanent loss of neurons caused by disorders connected to age. One such age-

related illness is Alzheimer's disease (AD). 

 

AD is a neurodegenerative disease. Approximately 36 million individuals worldwide struggle with AD, accounting for roughly 

6% of the population over 65[1]. Multiple cognitive deficits, personality changes, and inappropriate behavior are characteristics of 

AD. Amyloid beta peptide and hyperphosphorylated tau protein are the main pathogenic markers seen in AD brain tissues, although 

the specific pathways causing these changes are yet unknown. Aggregating extracellular senile plaques (SP) cause amyloid B protein 

formation, whereas aberrant p-tau protein deposits generate neurofibrillary tangles (NFTs) [2]. It causes neuronal death, altered 

synaptic design and functioning, and eventually the clinical signs of AD.Both the cholinergic and glutamatergic neuronal signal 
transmission systems, which are important for cognition are impacted in Alzheimer patients, in particular, damaged cholinergic 

system is to blame for a reduction in memory and cognition in AD sufferer. Oxidative stress is recognized as both cause and treatment 

objective for AD. Excessive ROS production can ultimately harm neurons, lipids, and peptides. Additionally, AD is associated with 

mitochondrial malfunction, inflammatory reactions, impaired neurotransmissions, synaptic damage, hormonal changes, and 

irregularities in cell cycle. Acetylcholine levels rise in the brain, which lowers inflammatory cytokine production. In the case of elder 

people, a low level of ach can increase inflammation and exacerbate the disease. Long-term exposure to Some chemicals like 

streptozotocin, scopolamine, alcohol, heavy metals (AlCl3, Cu, Zn, Pb), and reducing sugar(d-galactose) induces neuronal toxicity 

that leads to Alzheimer’s disease[3]. Various methods and models (open field, T-maze, Ymaze,Elevated plus maze,IR Actimeter) 

are developed to evaluate the AD. Therefore, the study aimed to identify the protective effect of Causonis trifolia (L.) extract on 

AlCl3 neurotoxicity model for AD to compare the behavior changes and histopathology of hippocampus in Wistar rat. 
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CHAPTER TWO 

REVIEW OF LITERATURE 
 
 History of Alzheimer’s Disease:  

Alzheimer’s disease was first recorded in an autopsy on Auguste Deter, 55-year-old lady who passed away from a degenerative 

behavioural and cognitive disease, which was reported by Alois Alzheimer in 1906. Alzheimer noted the presence of two distinctive 

pathologies in Deter’s brain: neurofibrillary tangles, which he correctly surmised were abnormal intracellular aggregates (and which 

were later shown to be composed of hyperphosphorylated and cleaved forms of the microtubule-associated protein tau), and neuritic 

plaques (which he called miliary foci), which were dystrophic neuronal processes surrounding a “special substance in the cortex” 

(Alzheimer et al. 1995). Glenner & Wong (1984) isolated and purified this "special substance," demonstrating that it was a 4.2-kDa 

peptide with a primary length of 40 or 42 amino acids, which they assumed was cleaved from a larger precursor. The peptide that 

Glenner and Wong identified today is called the Aβ peptide, which stands for amyloid-β peptide. 

 

Brain tissue changes in Alzheimer’s disease: Each neuron has long, branching extensions that allow them to connect. These 
connections, known as synapses, facilitate the flow of information through tiny bursts of chemicals that one neuron releases and 

another neuron absorbs. The brain is made up of trillions of synapses. These little connections help signals zip through the brain 

quickly, forming the foundation for our memories, thoughts, sensations, feelings, movements, and skills. Over time, researchers have 

discovered various changes in the brain that can disrupt these chemical signals, which may result in difficulties with thinking, 

learning, and daily activities, often seen in individuals with Alzheimer’s disease. The accumulation of the protein fragment beta-

amyloid into clumps (called beta- amyloid plaques) outside neurons and the accumulation of an abnormal form of the protein tau 

(called tau tangles) inside neurons are two of several brain changes associated with Alzheimer’s disease. Beta-amyloid and tau have 

different roles in Alzheimer’s. Plaques and smaller accumulations of beta-amyloid may damage neurons by interfering with neuron-

to-neuron communication at synapses [8,25]. Inside neurons, tau tangles block the transportation of nutrients and other molecules 

essential for the normal function and survival of neurons while harming connections between neurons [9,10]. Beta-amyloid and tau 

accumulation is followed by damage to and destruction of neurons (called neurodegeneration) and other brain cells. 

Neurodegeneration, along with beta-amyloid and tau accumulation, is a key feature of Alzheimer’s disease. The presence of toxic 
beta-amyloid and tau proteins is believed to activate immune system cells in the brain called microglia [11]. Microglia try to clear 

the toxic proteins and debris from dead and dying cells. Chronic inflammation may set in when the microglia can’t keep up with all 

that needs to be cleared. Another brain change associated with Alzheimer’s disease is atrophy (decreased brain volume) resulting 

from neurodegeneration and other factors [12]. While some degree of brain atrophy is common in older age, even in people who are 

cognitively healthy, atrophy is accelerated in people with Alzheimer’s dementia [13]. Normal brain function is further compromised 

by decreases in the brain’s ability to metabolize glucose, its main fuel. 

 

 Types of Alzheimer’s Disease:  

In addition to biomarker evidence of Alzheimer's-related brain alterations, dementia caused by Alzheimer's disease is defined 

by observable memory, language, thinking, or behavioral symptoms that make it difficult for a person to function in everyday 

life[14]. 

 

 Mild Alzheimer’s Disease:  

While most people with mild Alzheimer's dementia may operate independently in many areas, they will probably need 

assistance with some tasks to maintain their safety and optimize their independence[15]. 

 

They could still be able to work, drive, and engage in their preferred pastimes. They can require extra time to finish everyday 

activities. It might be particularly difficult to make financial decisions and pay expenses. 

 

 Moderate Alzheimer’s Disease:  

The intermediate stage of Alzheimer's dementia, which is frequently the longest stage, is characterized by increased memory 

and language difficulties, a higher risk of confusion, and difficulty doing multistep tasks like dressing and washing[16]. They could 
occasionally become incontinent, start having trouble identifying loved ones, and exhibit behavioral and impatient changes including 

anxiety and suspicion[17]. 
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Fig 1 Flow Chart of Different Types of Alzheimer’s Disease 

 

 

 Severe Alzheimer’s Disease:  

People with Alzheimer's dementia who are in the severe stage have significantly reduced verbal communication skills and are 

likely to need 24-hour care. Walking may be impossible for certain people due to impairment to the parts of the brain involved in 
movement. They could thus spend the most of their time on a bed or in a wheelchair. Because they are less mobile, they are more 

susceptible to physical problems including blood clots, skin infections, and sepsis, which causes inflammation throughout the body 

and can lead to organ failure. It becomes challenging to eat and drink when the part of the brain that regulates swallowing is damaged. 

As a result, people may swallow food into their windpipe (trachea) rather than their esophagus (food pipe). Aspiration pneumonia 

is a kind of lung infection that can develop from food particles getting lodged in the lungs. One of the main causes of mortality for 

many people with Alzheimer's disease is aspiration pneumonia.[18] 

 

 Different Hypotheses Related to AD: 

 

 Tau Hypothesis:  

Previously, Aẞ had been the focus of AD research. Researchers have now started to pay more attention to tau proteins since 

several investigations have indicated that they are among the essential components of NFTs. Tau protein is a functional monomeric, 
unfolded cell membrane protein and a member of microtubule-associated protein located within a neuron's cytosol. It Plays a critical 

role in tubulin stabilization. According to the tau hypothesis, normal tau is transformed into the paired helical filament (PHF-tau) 

and NFTS when the tau protein is hyperphosphorylated.[19,20,71] According to recent research, hyperphosphorylated tau that 

breaks down into oligomers (the toxic form of tau) is associated with neuronal damage, but still NFT itself does not seem to be 

linked to neurotoxicity that results in the development of neurodegeneration. [21,85] 

 

 Amyloid Cascade Hypothesis: 

According to the amyloid cascade theory, the pathophysiology of AD is significantly influenced by amyloid plaques, which 

are created by the buildup of Aß peptides and originate from the proteolytic dissociation of APP. Amyloid B precursor protein 

(ABPP), an intrinsic type I glycoprotein with a wide ectodomain, is the source of the Aß peptide.[49,50,51,52] Research has 

demonstrated that polypeptides (about 4 kDa) typically synthesised in soluble form make up the majority of amyloid plaques in 
AD.[21] There are many isoforms of the Aẞ protein, most of which have between 39 and 43 amino acids.[ The ectodomain of the 

two APP isoforms, APP751 and APP770, is composed of 56 amino acids. The majority of the several Aẞ protein isoforms include 

between 39 and 43 amino acids. [22] 

 

 Oxidative Stress Hypothesis: 

The pathophysiology of AD is thought to be significantly influenced by oxidative stress. During mitochondrial respiration, the 

brain is known to use more energy and perform more tasks than any other organ, which also raises the risk of exposure to reactive 

oxygen species (ROS). Moreover, AD is intimately associated with lipid peroxidation, glycoxidation, protein oxidation, protein 

nitration, and molecular oxidative stress. Additionally, AD is intimately associated with Aß aggregation, which has been shown to 

result in oxidative stress.[21] 

 

 Cholinergic Hypothesis:  

The Cholinergic Hypothesis is the earliest of the AD causative ideas. According to this theory, the etiology of AD is caused 

by a reduction in neurotransmitters called acetylcholine in neurons. It has been proposed for over thirty years, implicated that the 

cognitive impairment observed in AD patients is caused by aberrant acetylcholine-containing neurons in the basal ganglia.[23] 

 

 Mitochondrial Cascade Hypothesis:  

Swerdlow was the first to suggest the mitochondrial cascade hypothesis in 2004. According to this idea, the primary cause of 

Aẞ accumulation, NFT development, and synaptic degradation in AD is mitochondrial abnormalities. It assumes that the aging brain 
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and AD have comparable physiological pathways. Given that AD is characterized by systematic mitochondrial failure, it says that 
mitochondrial malfunction alone cannot adequately reflect the consequences of neuronal dysfunctions. [21,60,77] 

 

 Chemicals:  

Aluminium chloride (AlCl3) given by orally(175mg/kg) Aluminum chloride (AlCl3) can induce Alzheimer's disease (AD) by 

causing oxidative stress, inflammation, and apoptosis. [24] 

 

Oxidative stress: AlCl3 can interact with plasma membrane lipids, causing lipid peroxidation and oxidative stress. Oxidative 

stress is linked to the progression of AD. 

 

Inflammation: -AlCl3 can cross the blood-brain barrier and cause inflammation in the brain. This inflammation can lead to 

memory loss. [ 
 

Apoptosis: -AlCl3 can cause apoptosis by increasing the expression of the DAXX protein. DAXX is associated with the FAS 

protein, which is critical for apoptotic signaling. 

 

 Drugs:  

Donepezil (2.5mg/kg), orally administrated will use as a standard drug. Donepezil is commonly used in Alzheimer's disease 

because it is a cholinesterase inhibitor, which works by increasing the levels of the neurotransmitter acetylcholine in the brain, 

according to the National Institutes of Health (NIH).[25] Acetylcholine plays a crucial role in memory and cognitive function, and its 

levels are reduced in Alzheimer's disease. By inhibiting the breakdown of acetylcholine, donepezil can help improve or stabilize 

cognitive function and other symptoms associated with the disease. 

 

 Mechanism of Action: 

Donepezil works by binding to and inhibiting the enzyme acetylcholinesterase, which is responsible for breaking down 

acetylcholine in the brain. Donepezil hydrochloride, a piperidine derivative, is a fast-acting and reversible medication that works in 

the brain to block the enzyme acetylcholinesterase.[26] This enzyme is responsible for breaking down acetylcholine, a 

neurotransmitter. By stopping acetylcholinesterase from breaking down acetylcholine, donepezil increases the amount of 

acetylcholine available in the brain's synapses. This boosts cholinergic transmission, which is beneficial for treating Alzheimer's 

disease.[27] 

 

Cholinergic Transmission by inhibiting acetylcholinesterase, donepezil increases the amount of acetylcholine available at the 

synapses, where nerve cells communicate. Cognitive Improvement: This enhanced cholinergic transmission can lead to 

improvements in memory, attention, and other. 

 
 Side-Effect of Donepezil Tablet: 

Diarrhoea, Feeling sick (nausua), Headache, Feeling sleepy in the daytime or feeling dizzy. [ 

 

 Plant Description: 

Causonis trifolia commonly known as bush Grape, fox-grape, three-leaved wild vine or threleaf cayratia is a species of liana 

plant native to Australia and Asia. It has black-colored berries, and its leaves contain several flavonoids, such as cynadin and 

hydrocyanic acid is present in the stem, leaves and roots.[29] 

 

 Scientific Classification: 

 

Table 1 Scientific Classification: 

Kingdom Plantae 

Clade Tracheophytes,Angiosperms 

Order Vitales 

Family Vitaceae 

Genus Causonis 

Spcies C.trifoia 

Biological Name Causonis trifolia 

 
The vernacular names for Causonis trifolia (L.) include: Bush grape, Fox-grape, Three-leaved wild vine, Three leaf cayratia, 

and Yugali. 
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Fig 2 Pant Causonis Trifolia 

 

 Plant Morphology  

Kangaroo vine is a perennial climbing vine or shrub, popular when grown as a houseplant, partial Sun loving, bushy, Long 

height.[30] 

 

 Stems:  

Vine stem diameters were measured up to 7 cm. 

 

 Leaves:  

The underside of the pamphlet blades' utmost hairs are often hooked, especially on the midrib. With a lens, "oil painting 

blotches" are easily visible. The emulsion of tendrils splint-opposed has multiple branches, each of which ends in a distended 

structure that resembles a haustorium that grows in crevices and cracks. In the outgrowths, there is "oak grain." [31] 

 

 Flowers:  

Terminal or inflorescence leaf-opposed. flowers with a diameter of 4 mm. cup-shaped calyx, 0.2 mm long, without lobes. The 

apices are hooded, the outer surface is covered in hairs, and the petals are about 2.5 mm long. filaments that are about 1.5 mm long. 

Pale yellow, lobed disk, 0.8 mm high. pyramidal style. Each locule has two ovules. [31;32] 
 

 
Fig 3 Leaf of Causonis Trifolia 
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 Fruit:  
globular, depressed fruits, 8-10 x 10-19 mm. About 5-7 x 2.5-5 mm seeds. The inner testa is brown and extremely hard, with a 

rugose surface, while the outer testa is soft and greenish brown. The cotyledons are slightly wider but shorter than the radicle, and 

the embryo is roughly 0.75–1 mm long.[31] 

 

 Seedlings:  

Elliptic to ovate cotyledons, measuring roughly 25–26 x 16–17 mm. The initial leaf is simple, toothed, or bifoliolate, with a 

tendency to trifoliate. The second leaf trifoliates. Hairs cover the lower surface, while the upper surface—aside from the midrib—

is glabrous. At the tenth leaf stage, the stalk is roughly 0.8–1 cm long, and the middle leaflet blade is roughly 3.5–4 x 2.2–2.7 cm. 

Bases are oblique, stalks are between 0.2 and 0.6 cm long, and lateral leaflet blades measure roughly 2.5 to 3.5 x 2-2.5 cm. Seeds 

take 20 to 192 days to germinate. 

 

 
Fig 4 Flower of Causonis Trifolia 

 

 Pharmacological Activities: - 

 

 Antioxidant activities:  

The primary source of the plant's remarkable antioxidant properties is its high phenolic content. These chemicals can reduce 

oxidative stress and perhaps minimize the chance of acquiring chronic diseases by neutralizing free radicals.[33] 

 

 Anti-Inflammatory Properties: 

Causonis trifolia has important characteristics like: 

 

 BSA Inhibition Denaturation: The extract stops bovine serum albumin's (BSA)inflammatory process from denaturing. 

 Protease Inhibition: This inhibits trypsin, a serine protease linked to inflammatory responses. 

 Hemolysis Inhibition: By inhibiting heat-induced hemolysis, the extract demonstrates membrane-stabilizing qualities.[34] 

 

 Antidiabetic Effects: 

The plant exhibits encouraging antidiabetic effects by: 

 

 α-Amylase Inhibition: The extract reduces the absorption of glucose by inhibiting α-amylase, the enzyme that breaks down starch. 

 Enhancement of Glucose Uptake: It makes yeast cells more sensitive to insulin by increasing their uptake of glucose. 
 

 Antimicrobial Properties: 

Catechin, kaempferol, gallic acid, caffeic acid, and sinapic acid are among the phenolic and flavonoid compounds found in 

Causonis trifolia, which also has antioxidant properties.[35] 

 

 Geographical Distribution: - 

 

• Asia: - China, India, Bangladesh, Nepal, Pakistan, Philippines and Sri Lanka 
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• Australia: - western Australia 

 

 Uses: - 

The plants material is used to treat splenopathy, neuralgia, tumors, and as a diuretic. Scurvy is treated with leaf decoctions, 

which are made from the juice of fresh leaves. The roots have anti-venom properties and are used as an astringent. While the 

powdered root tuber is taken orally with milk to promote the early healing of cracked bones, diabetic patients are given an aqueous 

extract of the root along with the infusion of seeds to regulate blood sugar levels. [36,37] 

 

 Aim & Objectives 

 

 Aim:  
To evaluate the phytochemical screening and anti-Alzheimer’s activity of the Causonis trifolia (L.) 

 

 Objectives:  

To study the phytochemical constituent of Causonis trifolia (L.). By the isolation, we may determine the active constituents 

which are responsible for Anti-Alzheimer activity in rodents 
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CHAPTER THREE 

MATERIALS & METHODS 
 
 Materials and Methods: 

 

 Animals:  

Twenty-five adult Wistar rats were taken, age should be between four weeks to six weeks. Randomly divided them into five 

groups, each group containing five animals. They were kept in a well-maintained animal house where everything should be 

controlled. Placed in a stainless-steel cage, the Temperature should be in between 22º to 25º C. Humidity should be 55 to 70 

percent.12/12 hours dark light cycle should be maintained with access to food and drinking water. The international standards for the 

care and use of laboratory animals were followed during the experimental procedures. 

 

 Chemicals:  

Aluminium chloride (AlCl3) given by orally(175mg/kg) Aluminum chloride (AlCl3) can induce Alzheimer's disease (AD) by 
causing oxidative stress, inflammation, and apoptosis.[39] 

 

 Drugs:  

Donepezil (2.5mg/kg), orally administrated will use as a standard drug. 

 

 Plant Extract:  

Ethanolic extract of Causonis trifolia 

 

 Preparation of Causonis Trifolia (L.) Extract and Authentication:  

Causonis trifolia (L.), also called "fox grape" (synonym: Cayratia trifolia (L.), we collected it from the local area of Uluberia 

and authenticated it from Shivpur Botanical Garden, Howrah. Authentication number: CIPT/2024/02. 
 

 Requirements: 

 

 Equipment’s: Conical flask, filter paper, beaker, glass rod 

 Chemicals: Petroleum ether, Ethanol Coarse powder of Causonis trifolia 

 

 Steps Involved in the Extraction Process: 

 

 Collect the plant leaves, wash them properly with fresh water, and dry them at room temperature for 7 to 10 days. 

 Dry leaves of the Causonis trifolia (L.) were grinded properly to get a coarse powder. The total weight of coarse powder was 

99.56 gm. 
 The coarse powder was properly mixed in petroleum ether solvent at a 1:10 ratio and kept for 3 days. 

 Petroleum ether and extract residue differentiated with filter paper and kept at room temperature to dry the residue. 

 Dry residue went to the 3-day extraction method in an ethanolic medium. 6.Collected extract was stored in dry and cool places 

at 4ºC. 
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Fig 5 Extraction Procedure of Causonis Trifolia Leaf 

 

 Evaluation of Phytochemical Characteristics: 

 
Table 2 Test for Alkaloids: 

Test Procedure Inference 

Mayer’s Test Mix a few ml of extract solution of mercuric chloride and potassium iodide Cream colored formed 

Wagners’s Test 1ml of extract solution few drops of iodine and potassium iodide were added. Reddish brown 

Dragendroff’s test 1ml of extract solution + Potassium bismath nitrate Reddish brown 

Hager’s test 1ml of extract solution few drops of saturated solution of picric acid Yellow coloured 

 

Table 3 Test for Flavonoids: 

Test Procedure Inference 

Shinoda test Four pieces of magnesium filings are added to the ethanolic extract 

followed by a few drops of concentrated hydrochloric acid. 

Pink colour formed 

Sodium hydroxide test About 5 mg of the compound is dissolved in water, warmed, and filtered. 

10% aqueous sodium hydroxide is added to 2 ml of this solution. 

This produces a yellow 

colouration. 

 

Table 4 Test for Carbohydrate: 

Test Procedure Inference 

Molish’s Test Aqueous extract+ Alpha naphthol in alcohol+ con.H2SO4 Violet ring at the junction of two liquids 

Barfaed’s Test Mix equal volumes of Barfaed’s reagent and test sample then heat 

up and cool for a few minutes. 

Red colour precipitated 

Benedict’s test Mix equal volume of Barfaed’s reagent and test sample then heat 

up. 

Red colour appears 

 

Table 5 Test for Protein: 

Test Procedure Inference 

Biuret Test NaOH + 1% CuSO4 Violet or Pink colour 

Millon’s Test Metalic mercury+ Nitric acid+ water White precipitated which turns into red upon 

heating 

Xanthoprotic test Test sample+Conc.H2SO4+ Strong NH3 Solution test 

for sulpher-containing proteins NaOH+ Lead acetate 

White PPT which turns into yellow upon heating, 

black or brownish due to pbs formation 

 
 Auto-Docking Process: - 

A complete procedure for molecular docking using Auto-Dock (AutoDock4 with Auto-Dock Tools, not Auto Dock Vina). 
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This guide assumes you're working on a Linux or Windows system with Auto-Dock and Auto-Dock Tools installed. [41,42,43] 
 

 Auto Dock Docking Procedure: - 

 

 Prepare Files 

 

 Prepare Receptor (Protein) 

 

 Download the protein structure from the RCSB PDB database (.pdb file). 

 Open in Auto Dock Tools (ADT): 

 

o Load the PDB file. 
o Remove water molecules (Edit > Delete Water). 

o Add polar hydrogens: Edit > Hydrogens > Add > Polar Only. 

o Add Kollman charges: Edit > Charges > Compute Gasteiger. 

o Save as. pdbqt: File > Save > Write PDBQT. 

 

 Prepare Ligand (Small Molecule) 

 

 Draw or obtain ligand in .mol or .pdb format. 

 Load into ADT. 

 Add hydrogens: Edit > Hydrogens > Add > All Hydrogens. 

 Compute Gasteiger charges: Edit > Charges > Compute Gasteiger. 

 Detect torsions: Ligand > Torsion Tree > Detect Root, then define rotatable bonds. 
 Save ligand as .pdbqt. 

 

 Set Up Grid Box 

 

 Open receptor in ADT. 

 Set up grid box: Grid > Grid Box. 

 

 Adjust center of the box (based on active site or known ligand position). 

 Set dimensions (size in x, y, z). 

 Recommended spacing: 0.375 Å. 

 
 Save grid parameter file (.gpf): Grid > Output > Save GPF. 

 

 Set Docking Parameters 

 

 Docking > Macromolecule > Set Rigid Filename: Load your receptor. pdbqt. 

 Docking > Ligand > Choose: Select your ligand. pdbqt. 

 Set parameters under Docking > Search Parameters: 

 

 Algorithm: Genetic Algorithm (GA). 

 Number of runs: 10–100. 

 
 Save docking parameter file (.dpf): Docking > Output > Save DPF. 

 

 Run AutoGrid and AutoDock 

 

Use command-line terminal (CMD/Terminal): bash 

 

Copy Edit 

 

Autogrid4 -p receptor.gpf -l receptor.glg 

 

Autodock4 -p ligand.dpf -l ligand.dlg 

 
 .glg = grid log file 

 .dlg = docking log file (results) 
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 Analyze Results 
 

 Open. dlg in ADT. 

 Analyze> Docking > Open and load. dlg. 

 Analyze> Conformations > Play, Cluster to view binding poses. 

 View binding energy, RMSD, and interactions. 

 

 Optional Tips 

 

 For batch docking, use scripting. 

 Use AutoDockVina if you need faster performance. 

 Use PyMOL or Chimera for better visualization of binding. 
 

 Catalase Activity Assay 

 

 Sample Preparation:  

Our rat blood sample was taken by retroorbital puncture with anticoagulant (sodium citrate) and centrifuge at 1000×g for 10 

minutes at 4⁰C. Collect the supernatant and keep it on ice. [45,46] 

 

 Solutions Preparation: 

Use the following reagents in the kit to prepare the solutions accordingly- 

 

Table 6 Different Reagents Provide in Estimation Kit. 

Solution ID Cat. No. Solution Description Quantity 

Buffer-1 OPKA005-A Sodium Phosphate Buffer 1100ml 

Solution A OPKA005-A Peroxide Stock Solution 250ml 

Solution B OPKA005-A Ammonium Molybdate Solution 110ml 

Enzyme OPKA005-A Catalase (1000U/ml) 50ml 

 

 Enzyme Solution:  

Dilute the Catalase Enzyme by adding 10μl Enzyme to 90μl buffer solution to get enzyme solution of 100 U/ml. Keep in ice 

until use.[50,51,52]  

 

 Substrate Solution: Dilute Peroxide solution by adding 25μl solution A to 10 ml of buffer 1(prepare just before use of the assay; 

stable for 1-2 days).  

 Solution B: Ammonium Molybdate solution should be used undiluted. 
 

 Bioassay: 1st Set the Groups as: 

 

 Set-1: Buffer blank 

 Set-2: Substrate blank 

 Set-3: Positive control 

 Set-4 (and other): Test sample 

 Set-5 (and other): Test sample blank 

 

 Now, follow the table as reference for reaction set up in micro-test plate: 
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Fig 6 Different Lamda Value Showing in ELISA Reader 

 

 Experimental Procedure: 

 

 Add 90μl of substrate solution to the wells defined for set 2, 3 & 4 in the micro-titre plate. 

 Add 100μl of buffer-1 to set-1, 10μl to set-2 and 90μl to set-5. 

 Add 10μl of enzyme solution to set-3, serve as positive control. 

 Add 10μl of sample to set-4 and set-5. 

 Incubate at 37⁰C for 5 minutes. 

 Add 100μl of solution B to each wells of the groups Set 1,2,3,4,5…. 

 Incubate at 37⁰C for 2 minutes. 
 Measure the absorbance at 374nm with microplate reader (Microplate reader with 350nm or 405nm filter will be sufficient to 

measure the absorbance). 

 Plate Setup: 

 

 
Fig 7 ELISA Microplate Reader 

 

 Calculations of Activity: 
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 T: time 

 S⁰: Mean absorbance of set 2 

 S: Mean absorbance of set 3 

 M: Mean absorbance of set 1 (correction factor) 

 Vt: total volume of reagents in test tube (200μl) 

 Vs: volume of sample (10μl). 

 

 ELISA Procedure for SOD Test: 

 

 Reagent Preparation:  

The 1X Wash Buffer was prepared by diluting 20 ml of the provided 25X Wash Buffer concentrate in 480 ml of deionized 
water. The Biotinylated Antibody and Streptavidin-HRP Conjugate for each assay (SOD, CAT, and GSH) were centrifuged briefly 

and diluted to the working concentration (100-fold) using the respective dilution buffers supplied in the kits. 

 

 Standard Preparation: 

The lyophilized standards were reconstituted with Standard Diluent as per kit instructions and gently mixed for 10–15 

minutes to ensure complete dissolution. A series of two-fold serial dilutions was prepared to generate a standard curve for each assay, 

covering a broad concentration range. A blank (0 concentration) was included using only the Standard Diluent. 

 

 Assay Procedure 

All standards and test samples were run in duplicate. The procedure for SOD, CAT, and GSH assays followed the sandwich (for 

SOD and CAT) ELISA formats provided by the kit protocol: 
 

 100 μl of standards, blank, and diluted test samples were added to the respective wells of pre-coated 96-well microplates. 

 The plates were sealed with adhesive covers and incubated at 37 °C for 1– 2 hours to allow antigen binding. 

 Wells were then aspirated and washed four times with 1X Wash Buffer. After each wash, residual buffer was removed by firmly 

tapping the inverted plate on absorbent paper, and the exterior of the wells was wiped to eliminate interference during the reading 

step. 

 100 μl of the diluted Biotinylated Antibody was added to each well, followed by incubation at 37 °C for 1 hour. 

 After washing as described, 100 μl of diluted Streptavidin-HRP Conjugate was added and the plates were incubated at 37 °C for 

30 minutes. 

 The washing step was repeated four times to remove unbound conjugates. 

 100 μl of TMB substrate was added to each well and incubated at 37 °C for 10–15 minutes in the dark. A blue color developed 

in positive wells. 
 The reaction was terminated by adding 100 μl of Stop Solution, turning the color from blue to yellow. 

 The absorbance was measured at 450 nm using a microplate reader within 10–15 minutes of adding the Stop Solution. 

 

 Grouping of Animals: 

 

 Animals were Divided into Five Groups, Each of Five Animals. 

 

 Group 1: The control group was administered by saline water. 

 Group II: Disease control group orally administrated by aluminium chloride (175 mg/kg). (Negative control) 

 Group III: Animal oral administered by donepezil tablet standard (2.5 mg/kg) and Alzheimer's induced with aluminium 

chloride(175mg/kg). (Standard control) 
 Group IV: Animals were orally administered by extract(150mg/kg) which dissolved in CMC (0.3% w/w) solution and Alzheimer's 

induced with AlCl3. (Test control-1) 

 Group V: Animals were orally administered by extract(300mg/kg) which is dissolved in CMC (0.3-0.5 w/w) solution and 

Alzheimer's induced with Aluminium chloride(175mg/kg). (Test control-2) 

 

 Pharmacological Screening of the Extract for the Following Activity by Using Various Animal Models to Check the Anti- 

Alzheimer’s Activity: 

 

 Ir-Acti-Meter: 

 

 Principle:  

The Infra-red Acti-meter using infrared light beams, measures spontaneous activity. It is the perfect instrument for 
evaluating rodents' locomotor activity and exploration. The system is dependable for quick and simple drug testing in both day light 

and dark environments. 
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 The System Can be Used to Assess 
 

 Exploration of spontaneous locomotor activity. 

 Curiosity (detection of nose-spokes in hole-board). 

 

One square frame, a frame stand, and a hole board plate make up the IR Acti- meter system in its most basic form. There are a 

total of 32 infrared cells on the frame, 16 of which are on the X-axis and 16 on the Y-axis. The instrument control panel will show the 

total number of beam brakes in both acti-meter and hole board modes, as well as the number of brakes by an animal on each axis. 

When using in online mode, options for automatic cutoff, experiment name, comments, sex, group, and reading averaging are 

available. 

 

 Handling Procedure: 
 

 Switch ON the instrument 

The display will show ORCHID SCIENTIFICS for few seconds and then will the XYZ Counts, T-counts (total of X, Y & Z) 

and timer. (Please note that Z axis is optional). 

 

 X: represents number of beam breaks on X Axis (FRONT SIDE)  

 Y: represents number of beam breaks on Y Axis (LEFT SIDE)  

 Z: represents number of beam breaks on Z Axis 

 T: represents total of number of beam breaks on X, Y & Z Axis.  

 

The timer indicates the time from the start of the experiment. 
 

T HB: represents hole board mode 

 

Description of Keys: 

 

ACT: represents acti-meter mode 

 

PAUSE: To pause the experiment Timer & beam counts 

 

RESET: To reset the counts and timer to zero position 

 

 
Fig 8 IR-Actimeter 
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 Elevated Plus Maze (EPM):  
The elevated plus maze (EPM) is a test measuring anxiety in laboratory animals that usually uses rodents as a screening test 

for putative anxiolytic or anxiogenic compounds and as a general research tool in neurobiological anxiety research such as PTSD and 

TBI. The model is based on the test animal's aversion to open spaces and tendency to be thigmotaxic. In the EPM, this anxiety is 

expressed by the animal spending more time in the enclosed arms. 

 

The validity of the model has been criticized as non-classical clinical anxiolytics produce mixed results in the EPM test. 

Despite this, the model is still commonly used for screening putative anxiolytics and for general research into the brain mechanisms 

of anxiety. 

 

 
Fig 9 Elevated Plus Maze 

 

 Test Procedure:  

The EPM is a standard test of anxiety and spontaneous exploration, where the animals choose between exploring the closed 

arms, perceived as safer, or the more exposed open arms of the apparatus. 
 

Three 5-minute testing sessions will be performed, with the initial exposure to the apparatus repeated after 1 day and again 

after 7 days, to assess possible differences in habituation. 

 

A web camera placed above the apparatus will record the animals' behaviour. The digital tracking software will analyse the 

animals' locomotor activity (total distance) offline. 

 

 Novel Object Recognition (NOR) Task: 

 

 Principle 

The novel object recognition (NOR) test (also called the novel object discrimination test, one-trial discrimination test, and 
novel object detection test) relies on the tendency of a fish to discriminate between two objects. This test requires no conditioning, 

external rewards, or aversive stimuli. On the alzheimeric condition animal behavour is non exploratory. 

 

 Test Procedure: 

On the first day, an animal was put into the black square arena (70×70cm, the same as used for OF testing) for 5min to allow 

habituation to the environment. The following day, two identical objects (glass jars full of pebbles) were added into the arena to 

opposite corners, 15cm from the walls and the rat spent there 5min exploring the objects 

 

After a 1h retention interval, one object was shifted by 20cm and the animals was allowed to explore the objects for 3min (NOL 

test phase). On day 3, the animals explored the same identical objects in the same location as the previous day for 5min (NOR training 

phase). 

 
After the 1h retention interval, one object was changed to a novel one (glass cuboid container of a comparable size) and the rat 

explored both objects for 3min (NOR test phase). 
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Fig 10 Novel Object 

 

The behaviour of the animals were analyzed by a human observer using the Kenovea software, who noted object exploration 

and object climbing. 

 

DISCRIMINATION INDEX = Tn – Tf 

 

DISCRIMINATION RATIO = (Tn − Tf)/(Tn + Tf) 

 

Where Tn= Time spent in novel object, Tf= Time spent in similar objevct 

 

 Statistical Analysis:  
The data obtained from animal experiments were analyzed with kinovea Software by GraphPad (version 3.10.4.2). 

 

It will express as mean ± standard error of the mean. 

 

Results was considered to be statistically significant at p≤0.05. Significance levels were as follows: 

 

*Indicates p≤0.5 as significant 

 

**indicates p≤0.01 as highly significant 

 

***indicated p≤0.001 as very significant 

 
……****indicated p≤0.0001 as very very significant 

 

 Brain Isolation Procedure: 

Brain isolation process in rats typically involves euthanasia, skull removal, and careful dissection to extract the brain, 

followed by further processing depending on the specific research goals. This may include separating specific brain regions, 

removing meninges, and isolating cellular or subcellular fractions. 

 

 Here's a More Detailed Breakdown: 

 

 Euthanasia and Initial Steps: 

Rats are euthanized using methods like cervical dislocation (for mice) or decapitation (for both rats and mice).  
 

The head and neck area are often sprayed with ethanol for sterilization. A midline incision is made on the scalp, and the skull 

is exposed. 

 

 Skull Removal: 

The skull is carefully removed using bone cutters or rongeurs, starting from the cerebellum and moving towards the olfactory 

bulb. 
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The dura mater (outermost membrane covering the brain) is peeled back and removed with forceps. 

 

Specific bones like the zygomatic arch, coronoid process, and angular process may be cut to facilitate access to the brain. 

 

 Brain Extraction: 

A spatula or forceps are used to gently lift the brain out of the cranial vault. 

 

In some cases, the brainstem and cerebellum are carefully dissected away from the cerebrum. 

 

 Further Processing: 

 
 Brain Region Dissection: 

Depending on the research, the brain may be further dissected into specific regions like the cortex, hippocampus, or cerebellum 

using fine scissors and forceps. 

 

 Meninge Removal: 

The remaining meninges (membranes covering the brain) are carefully removed using forceps. 

 

 Isolation of Cellular or Subcellular Fractions: 

The brain tissue may be homogenized and centrifuged to isolate specific cell types or subcellular components like synaptic 

membranes. 

 

 Tissue Preservation: 
The isolated brain tissue or fractions may be preserved in solutions like phosphate-buffered saline (PBS) or other buffers, 

often on ice. 

 

 Important Considerations: 

All steps are typically performed at 4°C to maintain tissue integrity and minimize degradation. 

 

Protease inhibitors may be added to the buffer to prevent protein breakdown. 

 

Aseptic techniques are crucial to prevent contamination during the isolation process, especially when working with cells or 

subcellular fractions. 

 

 
Fig 11 Brain Isolation Procedure of Wistar Rat 
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CHAPTER FOUR 

RESULTS AND DISCUSSIONS 
 
A. Results: 

 

 Macroscopic Characters: 

 

 Size- Height- 12cm, Width- 7.5cm 

 Shape- Oval 

 Colour- Dark Green (upper surface), Pale Green (lower surface) 

 Surface characteristics – Smooth & Slightly waxy 

 Mergin- The leaf has teeth like structure 

 

 
Fig 12 Causonis Trifolia Leaf 

 

 Phytochemical Analysis of the Ethanolic Leaf Extract of Causonis Trifolia (L.) 
 

Table 7 Name of Different Tests and Results 

 Name of the Test Result 

Carbohydrate test Molish’s test Positive 

Barfeed’s test Negative 

Benedict’s test Negative 

Protein test Biurat test Negative 

Alkaloids test Mayer’s test Positive 

Dragendroff’s test Negative 

Test for steroids Salkowski’s test Negative 

Test for glycosides Liberman test Positive 

 Keller-killani test Negative 

 For anthraquinone glysosides Positive 

Test for flavanoids Shinoda test Positive 

 Alkaline reagent test Positive 

Others test Test for Phenol Positive 

 Test for Tannins Positive 

 Test for Saponin Negative 

 

 Metabolic Profiling by GC-MS Analysis:  

GC-MS analysis of ethanolic leaf extract of Causonis trifolia revealed the presence of total 20 Phyto-constituents These are 

tabulated with there R.T, C.M,M.W, M.F, and structure The main compound of plant extract which is useful against Alzheimer’s 

is 9-Octadecanoic acid. 

https://doi.org/10.38124/ijisrt/26feb693
http://www.ijisrt.com/


Volume 11, Issue 2, February – 2026                                      International Journal of Innovative Science and Research Technology 

ISSN No: -2456-2165                                                                                                              https://doi.org/10.38124/ijisrt/26feb693 

 

 

IJISRT26FEB693                                                                   www.ijisrt.com                                                                                1640 

 
Fig 13 Molecular Structure of 9- Octadecanoic Acid 

 

Table 8 Name of Different Compound Obtained from GC-MS Analysis 

 
 

 9-Octadecanoic Acid: 

It is an unsaturated fatty acid, which has a double bond at the ninth carbon atom. Also called as oleic acid. It prevents the 

breakdown of acetylcholine, a neurotransmitter crucial for memory and cognitive function, by the enzyme acetylcholinesterase 

(AChE). Also, oleic acid may possess anti-inflammatory and antioxidant qualities, which enhance its ability to fight against 

Alzheimer's disease. 
 

 Docking Results:  

Protein-ligand binding site give a good value, maximum score is -25.3. The modelled tau protein was phosphorylated and 

hyperphosphorylated from in silico perspective and later considered for active site identification based on the available tau 

crystal structure (PDB ID: 2MZ7) bound to microtubules. 
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Table 9 Different protein-ligand binding site with value 

 
 

 
Fig 14 Docking Molecule 

 

 High-Performance Thin Layer Chromatography (HPTLC) Finger Printing Analysis: - 
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Fig 15 HPTLC Plate View at UV 254nm, of Standard and Samples Developed in a Mobile Phase of Chloroform, Ethyl Acetate, and 

Formic Acid (5:4:1v/v/v). 

 

 
Fig 16 3 Peak of Naringenin and 2 Peak of Apigenin 

 

Table 10 Isolation of Bio-Active Compounds by HPTLC Finger Printing of Ethanolic Extract of Causonis Trifolia (L). 
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HPTLC Finger printing confirm the presence of Naringenin (Rf 0.756) and Apigenin (Rf 0.618). Through HPTLC finger 
printing, presence of Naringenin and Apigenin were confirmed from the ethanolic extract which is responsible for curing 

Alzheimer’s disease. 

 

 Naringenin:  

It is a natural flavanone, richly found in citrus and grape fruits, exhibits antioxidant potential, improves brain insulin signaling 

and cognitive functions and ameliorates AD-type neurodegeneration due to intracerebroventricular-streptozotocin (Khan et al., 

2012, Yang et al., 2014) 

 

 IR Acti-Meter: 

 

Table 11 Mean Value of Different Groups, Measured, Locomotion Score by IR- Acti-Meter. 

Group Treatment Locomotion score 

Day 1 Day 7 Day 14 Day 21 

I Normal Control (Saline water) 444.8±33.24 465.67±19.31 460.8±29.38 478.56±26.82 

II Disease control (aluminium chloride 
treated(175mg/kg) 

435.78±77.61 313.45±51.27 273.8±28.33 263.2±5.65 

III Standard control [Donepezil treated 

(2.5mg/kg)] 

444.4±54.59 515.67±51.45** 575±26.57**** 597.2±9.93**** 

IV Test-1[Causonis Trifolia extract 

(150mg/kg)] 

430.67±12.90 348.25±31 442.4±48.35** 484.25±56.54** 

V Test-2[Causonis Trifolia extract- 

2(300mg/kg) 

378.67±22.39 445.45±25.75 461.4±24.56** 498±52.84*** 

 

 
Fig 17 Graphical Representation of Effect of Ethanolic Leaves Extract (Doses 150 and 300 mg/kg) of Causonis Trifolia by IR 

Acti-Meter: 
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Where, 
 

Group-I: Normal control  

 

Group-II: Disease control  

 

Group III: Standard control 

 

Group IV: Test control 1(Extract 150mg/kg) 

 

Group V: Test control 2(Extract 300mg/kg) 

 
Values are expressed as mean± SEM, n=5; *P<0.1 **P<0.01,***P<0.001, ****P<0.0001 considered statistically 

significant as compared to disease control group. Statistical analysis done by disease control group followed by Oneway 

 

On day 14, Locomotor activity significantly increases, by our ethanolic extract. **p<0.01 compare to disease treated group and 

the standard drug Donepezil gives the more significant effect ***p<0.0001 Compare to disease treated group. 

 

But on day 7, only the standard drug for Shows the significant effect **p<0.01 Compare to disease treated group. 

 

On 21 days, our extract (300 mg/kg) showed more significant effect, ***p<0.001. and 150 mg/Kg extract shows significant 

effect (**p<0.01) Compare to the aluminium chloride group or disease treated group. On the same day the std drug (Donepezil) 

Shows much more significant ****p<0.0001 compare to disease treated group. 

 
 Elevated Plus Maze Test: 

 

 Entry into Open Arm: 

 

Table 12 Mean Value of Different Groups Measured, Entry into Open Arm by Elevated Plus Maze 

Group Treatment Entry into open arm 

Day 1 Day 7 Day 14 Day 21 

I Normal Control (Saline water) 27.8±4.25 23.3±1.46 21.6±1.63 30±1.92 

II Disease control (aluminium chloride treated(175mg/kg) 25.4±3.90 29.8±1.98 14.4±2.13 9.3±0.8 

III Standard control [Donepezil treated (2.5mg/kg)] 10±0.70 14.4±2.13**** 27.6±2.61** 29.8±4.25** 

IV Test-1[Causonis Trifolia extract (150mg/kg)] 9±0.70 14.4±2.13 24.8±1.98** 27.6±2.61** 

V Test-2[Causonis Trifolia extract- 2(300mg/kg) 9.4±1.02 22.8±1.98 27.6±2.61 28±2.4 
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Fig 18 Graphical Representation of Effect of Ethanolic Leaves Extract (Doses 150 and 300 mg/kg) of Causonis Trifolia by 

Elevated Plus Maze (Entry into Open Arm) 

 

Where, 

 

Group-I: Normal control  

 

Group-II: Disease control  

 

Group III: Standard control 

 

Group IV: Test control 1(Extract 150mg/kg)  
 

Group V: Test control 2(Extract 300mg/kg) 

 

On Day 14 and 21, animals were enter in the open arm significantly **p<0.01 which were treated with extract 

 

Values are expressed as mean± SEM, n=5; *P<0.1 **P<0.01, ****P<0.0001 considered statistically significant as 

compared to disease control group. Statistical analysis done by disease control group followed by Onaway ANOVA Test. 

 

 Compare to Disease Treated Group but Our Low Dose Extract Showed Less 

significant effect, *p<0.5 on day 14 but insignificant in day 21. whereas on day 7, our extract (150mg/kg) showed Significant 

effect ** ** p<0.0001as like as standard drug (Donepezil) compared to the disease control group on the 7,14,21 our 
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extract(150mg/kg) showed the more significant effect ****p<0.0001, *p<0.5, **p<0.01 compare to disease treated group. 
 

On Day 14, 21 our extract(300mg/kg) showed significant effect by spending less time Compare to the disease control Group 

** ** p< 0.0001, * ** p<0.001. Our lower dose extract also showed significant effect compare to disease treated group on 14, 21 

days * ** p<0.001 but our standard drug showed more significant effect. On day 7 and 1 by reducing the time spent in close arm 

**p<0.01, *p<0.5 and **p<0.01 by our extract(150mg/kg) compare to disease control group 

 

 

 Time Spents in Close Arm: 

 

Table 13 Mean Value of Different Group Measured, Total Time Spend in Close Arm by Elevated Plus Maze 

Group Treatment Time spent in close arm 

Day 1 Day 7 Day 14 Day 21 

I Normal Control (Saline water) 115.4±5.78 122.4±7.02 120.3±7.28 119.4±6.79 

II Disease control (aluminium chloride 

treated(175mg/kg) 

152.2±4.25 162.8±3 180.8±8.61 212.4±16.67 

III Standard control [Donepezil treated 
(2.5mg/kg)] 

170±0.70** 140.6±2.13** 125.4±2.61**** 122.4±9.24**** 

IV Test-1[Causonis Trifolia extract (150mg/kg)] 171±0.70** 132.8±3.23*** 140±1.98*** 145.4±6.15*** 

V Test-2[Causonis trifolia extract- 2(300mg/kg) 170.6±1.02** 146.2±1.98** 133.0±2.45**** 1452.5±4.26*** 

 

 
Fig 19 Graphical Representation of Effect of Ethanolic Leaves Extract (Doses 150 and 300 mg/kg) of Causonis Trifolia by 

Elevated Plus Maze (Time Spent in Close Arm) 
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Where, 
 

Group-I: Normal control  

 

Group-II: Disease control  

 

Group III: Standard control 

 

Group IV: Test control 1(Extract 150mg/kg) 

 

Group V: Test control 2(Extract 300mg/kg) 

 

 
 

On day 14,21 our extract (300mg/kg) showed significant effect by spending less time compare to the disease control group ** 

**p<0.0001, * **p<0.001. 

 

Our lower dose extract also showed significant effect compare to the disease treated group on day 14,21 days. * **p<0.001, 

but our std drug shows more significant effect, ** **p<0.0001. 

 

On day 7 and 14 our extract (300mg/kg) also showed significant effect, **p<0.01, *p<0.5 b y  reducing the spending t i m e  

a t  close arm and **p<0.01. by our extract (150mg/kg) compare to disease control group. Our standard drug also showed significant 

effect **p<0.01, compare to disease control group on day 7and day 14. 

 

 Novel Object Recognition Test: 

 

 Total Distance Travelled: 

 

 Similar Object: 

 

Table 14 Mean Value of Different Groups Measured, Total Distance for Similar Object by Novel Object Recognition Test 

Group Treatment Total distance for similar object(cm.) 

Day 1 Day 7 Day 14 Day 21 

I Normal Control (Saline water) 161.45±5.78 167.4±7.02 170.3±7.28 189.4±6.79 

II Disease control (aluminium chloride 

treated(175mg/kg) 

152.2±4.25 132.8±3 117.8±11.61 102.4±16.67 

III Standard control [Donepezil treated (2.5mg/kg)] 158±0.70 170.6±2.13**** 179.4±2.61**** 192.4±9.24 

IV Test-1[Causonis Trifolia extract (150mg/kg)] 141±0.70 152.8±3.23** 160±1.98*** 171.4±6.15 

V Test-2[Causonis Trifolia extract- 2(300mg/kg) 150.6±1.02 176.2±1.98**** 186.0±2.45**** 194.5±4.26 
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Fig 20 Graphical Representation of Effect of Ethanolic Leaves Extract (Doses 150 and 300 mg/kg) of Causonis Trifolia by Novel 

Object Recognition Test (Total Distance Travelled in Similar Object). 

 

 Novel Objects: 

 

Table 15 Mean Value of Different Groups Measured, Total Distance for Novel Object by Novel Object Recognition Test 

Group Treatment Total distance in novel object(cm.) 

Day 1 Day 7 Day 14 Day 21 

I Normal Control (Saline water) 121.45±5.78 122.4±7.02 130.3±7.28 109.4±6.79 

II Disease control (aluminium chloride treated(175mg/kg) 162.2±4.25 172.8±3 177.8±11.61 202.4±16.67 

III Standard control [Donepezil treated (2.5mg/kg)] 130±0.70 120.6±2.13 129.4±2.61 122.4±9.24 

IV Test-1[Causonis Trifolia extract (150mg/kg)] 141±0.70 132.8±3.23 127±1.98 111.4±6.15 

V Test-2[Causonis Trifolia extract- 2(300mg/kg) 120.6±1.02 136.2±1.98 126.0±2.45 114.5±4.26 
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Fig 21 Graphical Representation of Effect of Ethanolic Leaves Extract (Doses 150 and 300 mg/kg) of Causonis trifolia by Novel 

Object Recognition Test (Total Distance Travelled in Novel Object). 

 

Where, 

 

Group-I: Normal control  
 

Group-II: Disease control  

 

Group III: Standard control 

 

Group IV: Test control 1(Extract 150mg/kg) 

 

Group V: Test control 2(Extract 300mg/kg 

 

Values are expressed as mean± SEM, n=5; **P<0.01, ***P<0.001, ****P<0.0001 considered statistically significant as compared 

to disease control group. 
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 Time Spent: 

 

 Similar Object: 

 

Table 16 Mean Value of Different Groups Measured, Time Spent for Similar Object by Novel Object Recognition Test 

Group Treatment Time spent in similar object (sec.) 

Day 1 Day 7 Day 14 Day 21 

I Normal Control (Saline water) 120.45±5.78 112.4±7.02 100.3±7.28 109.4±6.79 

II Disease control (aluminium chloride 

treated(175mg/kg) 

162.2±4.25 152.8±4.2 167.8±11.61 172.4±16.67 

III Standard control [Donepezil treated 

(2.5mg/kg)] 

130±0.70**** 121.6±5.13** 109.4±2.61**** 72.4±9.24**** 

IV Test-1[Causonis Trifolia extract 

(150mg/kg)] 

121±0.70**** 112.8±3.23**** 87±1.98**** 71.4±6.15**** 

V Test-2[Causonis Trifolia extract- 

2(300mg/kg) 

100.6±1.02**** 106.2±7.98**** 98.0±2.45**** 64.5±4.26**** 

 

 
Fig 22 Graphical Representation of Effect of Ethanolic Leaves Extract (Doses 150 and 300 mg/kg) of Causonis Trifolia by Novel 

Object Recognition Test (Time Spent for Similar Object) 
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Table 17 Mean Value of Different Groups Measured; Time Spent for Novel Object by Novel Object Recognition Test 

Group Treatment Time spent in novel object (sec.) 

Day 1 Day 7 Day 14 Day 21 

I Normal Control (Saline water) 151.45±5.78 162.4±7.02 170.3±7.28 179.4±6.79 

II Disease control (aluminium chloride 
treated(175mg/kg) 

142.2±6.25 122.8±3.9 117.8±11.61 102.4±16.67 

III Standard control [Donepezil treated 

(2.5mg/kg)] 

160±7.70 171.6±2.13**** 179.4±2.61**** 182.4±9.24**** 

IV Test-1 [Causonis Trifolia extract 

(150mg/kg)] 

161±8.70 182.8±3.23**** 187±7.98**** 191.4±6.15**** 

V Test-2 [Causonis Trifolia extract- 

2(300mg/kg) 

160.6±6.02 196.2±1.98**** 198.0±2.45**** 199.5±4.26**** 

 

 
Fig 23 Graphical Representation of Effect of Ethanolic Leaves Extract (Doses 150 and 300 mg/kg) of Causonis Trifolia by Novel 

Object Recognition Test (Time Spent for Novel Object) 
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 Discrimination Index: 

 

Table 18 Mean Value of Different Groups Measured by Discrimination Index 

Group Treatment Discrimination index 

Day 1 Day 7 Day 14 Day 21 

I Normal Control (Saline water) 31±2.09 50±0.98 70±1.01 70±1.01 

II Disease control (aluminium chloride treated(175mg/kg) 20±5.31 30±2.28 50±5.98 70±3.02 

III Standard control [Donepezil treated (2.5mg/kg)] 30±2.28 50±4.90 70±4.57 110±4.95 

IV Test-1[Causonis Trifolia extract (150mg/kg)] 40±5.31 70±7.81 100±2.91 120±6.57 

V Test-2[Causonis Trifolia extract- 2(300mg/kg) 60±2.07 90±3.05 100±3.5 135±5.9 

 

 
Fig 24 Graphical Representation of Effect of Ethanolic Leaves Extract of Causonis Trifolia by Novel Object Recognition Test. 

(D.I) 
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Where, 
 

Group-I: Normal control  

 

Group-II: Disease control  

 

Group III: Standard control 

 

Group IV: Test control 1(Extract 150mg/kg) 

 

Group V: Test control 2(Extract 300mg/kg) 

 
Values are expressed as mean± SEM, n=5; *P<0.1 ,***P<0.001, ****P<0.0001 considered statistically significant as 

compared to disease control group. Statistical analysis done by disease control group followed by One way ANOVA test. 

 

After treating with our extract (150mg/kg) and (300mg/kg) on day 7, day 14 & day 21 shows the significant effect on the novel 

objeet recognition test****p<.0001 compare to the disease Control gr where AlCl3 - was induced. But on day 7, the standard drug 

(Donepezil)" Showed Less significant effect *p<.0.5 than our. extract but on day-14 the standard drug showed the significant effect 

***p<0.001 and day 21, the standard drug showed more significant effect****P<0.0001 like of our extract compare the to disease 

control groups. 

 

The animals were spending more time. in the novel object than the familiar object 

 

 Data Analysis of SOD Test and Catalase Activity Test: 
The mean absorbance for each standard and sample was calculated. For SOD and CAT (sandwich ELISA), the absorbance 

values were directly proportional to the analyte concentration, and values were obtained by interpolating from the standard curve. 

For GSH (competitive ELISA), the absorbance values were inversely proportional to the analyte concentration, and a standard curve 

was used to determine unknown sample values. Results were expressed in appropriate units 

 

Table 19 Mean Value of Anti-Oxidantal Enzymes (SOD and CAT) Activity 

Group Treatment Antioxidant enzymes 

SOD (µg/mg) CAT (µg/mg) 

I Normal Control (Saline water) 26.30±0.61 25.85±0.09 

II Disease control (aluminium chloride treated(175mg/kg) 15.23±0.82**** 9.87±0.66**** 

III Standard control [Donepezil treated (2.5mg/kg)] 21.46±0.62*** 29.18±0.50 

IV Test-1[Causonis trifolia extract (150mg/kg)] 29.05±0.85* 23.07±0.71 

V Test-2[Causonis trifolia extract-2(300mg/kg) 27.31±0.81** 22.01±1.05 

 

A 

 

 

B 
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C 

 

 

D 

 

 
E 

 

 

 

Fig 25 Haematoxylin & Eosin Staining of the Substantia Nigra Sections of the Wistar Rat. 

 
(A) Normal Control: Cell layers are normal in size and uniformly arranged. (B)AlCl3 intoxicated: cellular infiltration (blue 

arrow), vesicular and enlarged nuclei (black arrow), hyperchromatic cells (green arrow), and some pyknotic cells (red arrows) in 

the striatum of the brain. (C) Donepezil treated: Shows a decrease in cellular infiltration (blue arrow), vesicular and enlarged nuclei 

(black arrow), hyperchromatic cells (green arrow), and some pyknotic cells (red arrows) in the striatum of the brain. (D) Extract 

lower dose: showed less expression of cellular infiltration (blue arrow), vesicular and enlarged nuclei (black arrow), hyperchromatic 

cells (green arrow), and some pyknotic cells (red arrows) in the striatum of the brain. (E) Extract with higher dose: Shows minimalistic 

expression of cellular infiltration (blue arrow), vesicular and enlarged nuclei (black arrow), hyperchromatic cells (green arrow), and 

some pyknotic cells (red arrows) in the striatum of the brain. 
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CHAPTER FIVE 

CONCLUSION 
 
 Conclusion: 

The study systematically evaluated the Anti-alzheimer’s activity potential of Causonis trifolia (L.) leaf extract through a 

comprehensive series of phytochemical screenings, GC-MS profiling, HPTLC fingerprinting, in vivo pharmacological models, and 

molecular docking analysis. The ethanolic extract exhibited a diverse phytochemical composition, rich in flavonoids, phenols, and 

alkaloids—key constituents known for their therapeutic effects against Alzheimer’s disease. GC-MS analysis confirmed the 

presence of active constituents like 9-octadecanoic acid, 2,4-thiazolidinedione, benzofuranone derivatives, and long-chain fatty 

alcohols that are capable of inhibiting pro-inflammatory mediators and oxidative stress. HPTLC analysis further verified the presence 

of Naringenin, flavonoids with well-established pharmacological benefits. Naringenin is responsible for anti-alzheimer’s 

activity.Molecular docking provided mechanistic insight, showing stable interactions between active compounds and protein 

residues involved in inflammation and pain signaling pathways.9-Octadecanoic acid prevents the breakdown of acetylcholine, a 

neurotransmitter crucial for memory and cognitive function, by the enzyme acetylcholinesterase (AChE). Also oleic acid may 
possess anti-inflammatory and antioxidant qualities, which enhance its ability to fight against Alzheimer's disease. These in silico 

results supported the observed in vivo efficacy.Protein-ligand binding site give a good value , maximum score is -25.3. The modelled 

tau protein was phosphorylated and hyperphosphorylated from in silico perspective and later considered for active site identification 

based on the available tau crystal Animal studies demonstrated that the extract significantly reduced time spent in close arm in EPM 

tests, suggesting curing Alzheimer’s disease. From EPM test, we obserbed that disease control animal have less activity and spent 

more time in close arm and less entry in open arm comparing to other groups. 

 

From IR Acti-meter, spontaneous mortility increased when compared in standard control group, test control 1, Test control 2 

and decreased in disease control group. Locomotor activity locomotor activity is the positive sign to recover from Alzheimer. 

 

From novel object recognition test we got positive sign and more time spent in novel object comparing to disease control 

group. 
 

In normal Control group: Cell layers are normal in size and uniformly arranged., In AlCl3 intoxicated: cellular infiltration, 

vesicular and enlarged nuclei , hyperchromatic cells , and some pyknotic cells in the striatum of the brain. In Donepezil treated group, 

it was seen that very less cellular dis arrangement observed, in test-1 gr represent less expression of cellular infiltration , vesicular and 

enlarged nuclei, hyperchromatic cells , and some pyknotic cells in the striatum of the brain in test -2 group, it was observed that 

minimalistic expression of cellular infiltration, vesicular and enlarged nuclei , hyperchromatic cells , and some pyknotic cells in the 

striatum of the brain. 
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